# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INTRODUCTION</strong></td>
<td></td>
</tr>
<tr>
<td>Qualified Persons</td>
<td>2</td>
</tr>
<tr>
<td>Read this Instruction Sheet</td>
<td>2</td>
</tr>
<tr>
<td>Retain this Instruction Sheet</td>
<td>2</td>
</tr>
<tr>
<td>Warranty</td>
<td>2</td>
</tr>
<tr>
<td>Latest Document Release</td>
<td>2</td>
</tr>
<tr>
<td><strong>SAFETY INFORMATION</strong></td>
<td></td>
</tr>
<tr>
<td>Understanding Safety-Alert Messages</td>
<td>3</td>
</tr>
<tr>
<td>Following Safety Instructions</td>
<td>3</td>
</tr>
<tr>
<td>Replacement Instructions and Labels</td>
<td>3</td>
</tr>
<tr>
<td><strong>CONTROL DEVICE HARDWARE AND SOFTWARE</strong></td>
<td></td>
</tr>
<tr>
<td>Applicable Software</td>
<td>5</td>
</tr>
<tr>
<td>Hardware and Faceplate</td>
<td>5</td>
</tr>
<tr>
<td>Control Device Software</td>
<td>6</td>
</tr>
<tr>
<td>SCADA Communication Equipment</td>
<td>6</td>
</tr>
<tr>
<td><strong>CONTROL DEVICE OPERATION</strong></td>
<td></td>
</tr>
<tr>
<td>Overvoltage Protection for Capacitor Banks</td>
<td>7</td>
</tr>
<tr>
<td>Protection for Reactors</td>
<td>7</td>
</tr>
<tr>
<td>Automatic Control Features</td>
<td>8</td>
</tr>
<tr>
<td>Ungrounded and Grounded Wye Shunt Capacitor Banks</td>
<td>9</td>
</tr>
<tr>
<td>Banks</td>
<td></td>
</tr>
<tr>
<td>Ungrounded Wye Shunt Reactors</td>
<td>12</td>
</tr>
<tr>
<td>Signal Processing</td>
<td>14</td>
</tr>
<tr>
<td><strong>GENERATING REPORTS</strong></td>
<td></td>
</tr>
<tr>
<td><strong>SAVING AND LOADING SETUP CONFIGURATIONS</strong></td>
<td></td>
</tr>
<tr>
<td>Saving the Setup Configuration</td>
<td>18</td>
</tr>
<tr>
<td>Loading a Saved Configuration</td>
<td>18</td>
</tr>
<tr>
<td><strong>VIEWING INTELLILINK SOFTWARE WITHOUT DATA</strong></td>
<td></td>
</tr>
<tr>
<td><strong>USING SNAPSHOTS (VM FILES)</strong></td>
<td></td>
</tr>
<tr>
<td>Save Control Settings and Data to a Snapshot</td>
<td>20</td>
</tr>
<tr>
<td>View (Connect To) a Snapshot</td>
<td>20</td>
</tr>
<tr>
<td>Save Changes You Make to the Snapshot</td>
<td>20</td>
</tr>
<tr>
<td>Generate a Report from a Snapshot</td>
<td>20</td>
</tr>
<tr>
<td>Create a CFG File From a Snapshot</td>
<td>20</td>
</tr>
<tr>
<td><strong>UPDATING CONTROL SOFTWARE</strong></td>
<td></td>
</tr>
</tbody>
</table>

---

S&C ELECTRIC COMPANY
Specialists in Electric Power Switching and Protection

Instruction Sheet 1011-540
February 13, 2006 ©2006
Supersedes 1011-540 dated 5-17-04
Qualified Persons

⚠️ WARNING

The equipment covered by this publication must be installed, operated, and maintained by qualified persons who are knowledgeable in the installation, operation, and maintenance of overhead electric power distribution equipment along with the associated hazards. A qualified person is one who is trained and competent in:

- The skills and techniques necessary to distinguish exposed live parts from non-live parts of electrical equipment.
- The skills and techniques necessary to determine the proper approach distances corresponding to the voltages to which the qualified person will be exposed.
- The proper use of the special precautionary techniques, personal protective equipment, insulating and shielding materials, and insulated tools for working on or near exposed energized parts of electrical equipment.

These instructions are intended only for such qualified persons. They are not intended to be a substitute for adequate training and experience in safety procedures for this type of equipment.

Read this Instruction Sheet

Thoroughly and carefully read this instruction sheet before programming, operating, or maintaining your IntelliTEAM II Interface Module. Familiarize yourself with “SAFETY INFORMATION” on pages 3 and 4.

Retain this Instruction Sheet

This instruction sheet is a permanent part of your IntelliTEAM II Interface Module. Designate a location where you can easily retrieve and refer to this publication.

Warranty

The standard warranty contained in S&C’s standard conditions of sale, as set forth in Price Sheet 150, is applicable to the IntelliTEAM II Interface Module.

Latest Document Release

The latest release of this instruction sheet is available online at www.sandc.com. Select: Support/Product Support Documents. Documents are posted in PDF format.
Understanding Safety-Alert Messages

There are several types of safety-alert messages which may appear throughout this instruction sheet as well as on labels attached to the IntelliTEAM II Interface Module. Familiarize yourself with these types of messages and the importance of the various signal words, as explained below.

⚠️ **DANGER**

“DANGER” identifies the most serious and immediate hazards which will likely result in serious personal injury or death if instructions, including recommended precautions, are not followed.

⚠️ **WARNING**

“WARNING” identifies hazards or unsafe practices which can result in serious personal injury or death if instructions, including recommended precautions, are not followed.

⚠️ **CAUTION**

“CAUTION” identifies hazards or unsafe practices which can result in minor personal injury or product or property damage if instructions, including recommended precautions, are not followed.

⚠️ **NOTICE**

“NOTICE” identifies important procedures or requirements that, if not followed, can result in product or property damage if instructions are not followed.

Following Safety Instructions

If you do not understand any portion of this instruction sheet and need assistance, contact your nearest S&C Sales Office or call S&C Headquarters at (773) 338-1000, Monday through Friday between 8:30 AM and 5:00 PM Central Standard Time. (In Canada, call S&C Electric Canada Ltd. at (416) 249-9171.)

⚠️ **NOTICE**

Thoroughly and carefully read this instruction sheet before programming and operating your IntelliTEAM II Interface Module.

Replacement Instructions and Labels

If you need additional copies of this instruction sheet, contact your nearest S&C Sales Office, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced immediately. Replacement labels are available by contacting your nearest S&C Sales Office, S&C Headquarters, or S&C Electric Canada Ltd.
This instruction sheet was prepared for use with software UPPD106S or later releases. You can find the release date on the Setup disk label. For questions regarding the applicability of information in this instruction sheet to future software releases, please contact S&C.

This section describes various control device components. The following section, Overview of Control Device Operations, explains how these components work together to monitor and manage capacitor bank/reactor operation.

Figure 1 shows hardware components of the control device that you may need to access during regular operation and troubleshooting.

The BankGuard PLUS faceplate includes LEDs and buttons which allow you to monitor the capacitor bank/reactor and the control device. It also includes a liquid crystal display and buttons for scrolling and selecting data.

- **Local communications port** – The control device has a port on its faceplate for local communication. If your control device includes communication equipment, it will usually be connected to the **SCADA COMM PORT** on the back.
- **Terminal strips** – Every BankGuard PLUS control device includes two numbered terminal strips for connecting to the external control wiring. Their configuration is shown in the Installation Instruction Sheet 1011-510.
S&C controls and devices are entirely software-driven. Each control device is shipped with Control Device software and IntelliLINK® software.

**Control Device Software**

Control Device software is preloaded into the control device in the factory. This software manages the minute-by-minute functioning of the control device. It continually monitors:

- voltage on the feeder
- incoming SCADA commands
- the state of the faceplate LEDs and buttons
- the internal control device clock/calendar
- the software setpoint values
- various other setpoints and data values as needed

Based on this information, the Control Device software decides how to respond to a change in voltage, a command from the faceplate or SCADA master station, and other conditions.

The Control Device software and the setpoint values are all stored in non-volatile control device memory. This memory survives power interruptions. The memory chip is a battery-backed RAM with a 20-year expected life in the powered state (10-year shelf life without power).

**IntelliLINK Software**

IntelliLINK software is supplied on the Setup disk and runs on IBM/PC-compatible computers. This software allows you to communicate with the Control Device software while you are at the control device site. Using the IntelliLINK software, you can:

- Enter installation-dependent operating parameters (setpoints), such as a network address, a voltage lockout level, etc.
- Monitor real-time data, such as the present line-to-ground voltage.
- Transfer all configuration, operating, and historical data from the control device to a "report" file on your computer.
- Download new Control Device software into the control device.
- Troubleshoot assorted types of control device installation problems.

**SCADA Communication Equipment**

Most communication equipment can be mounted near the control device. DNP 3.0 is the standard protocol for the BankGuard PLUS Control; other protocol options are also available.

For more details, see the appropriate Communication Points List, or contact S&C.
This section explains how the BankGuard PLUS controls the capacitor bank or reactor.

**Overvoltage Protection for Capacitor Banks**

Medium to large wye-connected shunt capacitor banks commonly use twofold protection against short circuits:

- Individual capacitor units are protected by fuse links that clear internal faults, reducing the probability of case ruptures.
- The system is protected against major faults by the bank protective device, such as power fuses or an S&C Circuit-Switcher.

If a fuse link operates to isolate a failed capacitor unit, the voltage across remaining units in the same series group will increase. This increased voltage can overstress and shorten the life of the other capacitor units in the group. As subsequent units fail, their isolation leads to further voltage increase on the remaining units. The result is an accelerating cascade of overvoltage that destroys good capacitor units.

This phenomenon is addressed in IEEE Standard 18-1992, “IEEE Standard for Shunt Power Capacitors.” The standard specifies a curve, see Figure 2, which indicates the permissible capacitor unit operating time at varying per-unit multiples of the capacitor nameplate voltage rating. This curve applies for up to 300 applications of power-frequency overvoltages of the magnitude and duration shown. (The standard further requires that capacitors be capable of continuous operation to at least 110% of the rated voltage, including harmonics. Most capacitor manufacturers publish similar data, which may permit higher working voltages.) When the voltage applied to the surviving capacitor units exceeds the manufacturer’s maximum recommended working voltage (or in the absence of a recommendation, the IEEE standard), the entire bank should be removed from service.

Thus, large-sized capacitor banks need a third form of protection: a control device that is sensitive enough to detect the isolation of the first failed unit in a capacitor bank, but sophisticated enough to disregard system and inherent bank imbalances, spurious transients, and harmonics. Also, the ability to alarm upon isolation of that capacitor unit lets the user replace it before additional failures occur.

**Protection for Reactors**

When a developing turn-to-turn fault occurs in any phase winding, the ungrounded, wye-connected shunt reactor is protected from further damage by automatic switching initiated by the BankGuard PLUS. The control device also will isolate and lock out the entire shunt reactor when a predetermined neutral-to-ground voltage is exceeded.
Automatic Control Features

The BankGuard PLUS control device provides the automatic features described in this section.

Bank/Reactor Lockout and Alarm

The lockout logic includes a user-selectable time delay (0.2 to 30 seconds). The time delay insures that the fuse for the failing capacitor unit operates before the control device locks out the bank, so you can quickly locate the failed capacitor unit.

The BankGuard PLUS includes a standard alarm function, which provides an alarm signal (after a time delay) upon the loss of fewer capacitor units than that corresponding to the lockout level setting. For many capacitor banks it is practical to activate the alarm at the loss of a single capacitor unit. This is a decided advantage since replacement of the failed capacitor unit can be accomplished at a convenient, planned time, instead of on an urgent basis during a lockout resulting from subsequent failure of capacitor units. If desired, the alarm function can alarm in respond to loss of control power to the BankGuard PLUS.

Alarms and lockouts are latched, and maintained across a software reset. They remain active until the ALARM INDICATOR RESET button or a SCADA command resets them.

Figure 2. Capacitor Unit Power Frequency Overvoltage versus Time (IEEE Standard 18-1992)
**Gross Overvoltage**

If a flashover of series groups within the capacitor bank or a failure of an entire reactor phase occurs, the gross overvoltage logic lets the control device react more quickly than the normal lockout process. This logic is activated, after a field adjustable time delay of 0.2 to 5 seconds, by such faults producing a capacitor bank neutral-to-ground voltage in excess of an adjustable level of 1000 to 5000 volts.

The BankGuard PLUS incorporates a digital input which is actuated through a contact of the capacitor bank switch-operator auxiliary switch. This digital input prevents nuisance operation of the BankGuard PLUS alarm or lockout functions resulting from neutral-to-ground voltages of several kilovolts being induced during periods when the capacitor bank has been routinely de-energized.

**Unbalance Compensation**

In larger capacitor banks, extraneous voltages can introduce significant errors in – or even overpower – the voltage signal created by the loss of individual capacitor units. For example, a fixed error voltage may be present due to inherent capacitor bank imbalances from manufacturing-tolerance variations among individual capacitor units, or due to system voltage imbalances from non-transposition of overhead lines. A variable error voltage may also be present due to a system load imbalance from changing load conditions. (This error voltage is usually only significant in very large, transmission-voltage-level capacitor banks.) Such error voltage can cause false operations that lock out the capacitor bank/reactor, or cause no operation when one is necessary.

The unbalance compensation feature (with the addition of station-bus voltage monitoring devices on ungrounded capacitor banks/reactors) lets the control device detect and compensate for the error voltage.

**Ungrounded and Grounded Wye Shunt Capacitor Banks**

The BankGuard PLUS Automatic Control Device provides protection of ungrounded (Figure 3) and grounded (Figure 4) wye-connected shunt capacitor banks. As individual capacitor units in a series group are isolated from the bank by their respective fuses, the control device automatically protects the surviving capacitor units in the group from cascading voltage overstress. The control device locks out the entire bank when the neutral-to-ground voltage exceeds the calculated level. (See the Setup Instruction Sheet 1011-530 for more details.) In general, you should enable the unbalance compensation feature if the magnitude of the error voltage caused by system voltage imbalances and/or inherent capacitor bank imbalances approaches 50% of the value of the neutral-to-ground voltage calculated for one isolated capacitor unit.
For ungrounded wye banks, the control device uses an analog input and digital voltmeter to detect the capacitor bank neutral-to-ground voltage, as monitored by an S&C 15-Volt-Ampere Potential Device. A digital filter attenuates harmonics and noise.

When the Unbalance Compensation feature is disabled, the magnitude of the real-time neutral-to-ground voltage is compared with the “Gross Over Voltage Level,” “Lockout Level,” and “Alarm Level” setpoint values, if enabled. Capacitor unit failures will cause the real-time neutral-to-ground voltage magnitude to change. If the real-time neutral-to-ground voltage magnitude exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The control will lock the bank out if the “Gross Over Voltage Level” or the “Lockout Level” setpoint value is exceeded. The control will issue an alarm if the “Alarm Level” setpoint value is exceeded.
In addition to the neutral-to-ground potential device, one 30-Volt-Ampere S&C Potential Device is required to be installed on any one of the line phases to obtain a reference angle when the Unbalance Compensation feature is set to “Cap Only.” During the setup of the Unbalance Compensation feature, a neutral-to-ground voltage magnitude sample and a reference angle ($\angle_{ref}$) sample are used to obtain and store an approximate magnitude correction value (see Signal Processing below for an explanation of how the value is calculated). Setup of the Unbalance Compensation feature should be accomplished during a time when any voltage unbalances caused by the loads are minimal. During each control cycle, the stored approximate magnitude correction value is subtracted from the real-time neutral-to-ground voltage magnitude to obtain a compensated neutral-to-ground voltage magnitude. Capacitor unit failures will cause the real-time neutral-to-ground voltage magnitude to change and, therefore, change the compensated neutral-to-ground voltage magnitude. The control compares the compensated neutral-to-ground voltage magnitude with the “Gross Over Voltage Level,” “Lockout Level,” and “Alarm Level” setpoint values, if enabled. If the compensated neutral-to-ground magnitude exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The control will lockout the bank if the “Gross Over Voltage Level” or the “Lockout Level” setpoint value is exceeded. Or issue an alarm if the “Alarm Level” setpoint value is exceeded. The “Cap Only” value is generally selected when the voltage variations between the line phases are expected to be negligible in comparison to the neutral-to-ground voltage changes resulting from the loss of capacitor units.

In addition to the neutral-to-ground potential device, three S&C 30-Volt-Ampere Potential Devices are required to be installed on each line phase when the “Unbalance Compensation” feature is set to “Cap/Line.” The control uses the three potential devices to obtain the sum of the line voltages magnitude and a reference angle. Since the sum is obtained from all the line voltages, compensation for fixed system imbalances is provided. During the setup of the unbalance compensation feature, a neutral-to-ground voltage magnitude sample, a sum of the line voltages sample and the reference angle are used to calculate and store a magnitude correction value (see Signal Processing below for an explanation of how the value is calculated). During each control cycle, the stored magnitude correction factor is subtracted from the real-time neutral-to-ground magnitude to obtain a compensated neutral-to-ground voltage magnitude. Capacitor unit failures will cause the real-time line-to-neutral voltage to change and, therefore, change the compensated neutral-to-ground voltage magnitude.

The control compares the compensated neutral-to-ground voltage magnitude to the “Gross Over Voltage Level,” “Lockout Level,” and “Alarm Level” setpoint values, if enabled. If the compensated neutral-to-ground voltage magnitude exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The control will lockout the bank if the “Gross Over Voltage Level” or the “Lockout Level” setpoint values are exceeded. The control will issue an alarm if the “Alarm Level” setpoint value is exceeded.

For grounded wye banks, the control device uses tap-voltage calibration logic. This logic develops the sum of the intermediate tap-point voltages on the 3 phase legs, as monitored by the S&C 30-Volt-Ampere Potential Devices. A digital filter attenuates harmonics and noise.

When the Unbalance Compensation feature is disabled, the magnitude of the sum of the intermediate tap-point-to-neutral voltages is compared (in percent) with the “Gross Over Voltage Level,” “Lockout Level,” and “Alarm Level” setpoint values, if enabled. Capacitor unit failures will cause the magnitude of the sum of the intermediate tap-point-to-neutral voltages to change. If the real-time magnitude of the sum exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The Control will lock out the bank if the “Gross Over Voltage Level” or the “Lockout Level” setpoint value is exceeded. The con-
trol will issue an alarm if the “Alarm Level” setpoint value is exceeded.

In addition to the three 30-Volt-Ampere Potential Devices, one 30-Volt-Ampere S&C Potential Device is required to be installed on any one of the line phases to obtain a reference angle when the Unbalance Compensation feature setpoint value is set to “Cap Only”. During setup of the Unbalance Compensation feature, a sample of the magnitude of the sum of the intermediate tap-point-to-neutral voltages and a reference angle sample are used to obtain and store an approximate magnitude correction value (See Signal Processing below for an explanation of how the value is calculated). Setup of the Unbalance Compensation feature should be accomplished during a time when any voltage unbalances caused by the loads are minimal. During each control cycle, the stored approximate magnitude correction value is subtracted from the magnitude of the real-time intermediate tap-point-to-neutral voltages sum. Capacitor unit failures will cause the magnitude of the real-time tap-point-to-neutral voltages sum to change, and therefore, change the magnitude of the compensated tap-point-to-neutral voltages sum. The control compares the compensated intermediate tap-point-to-neutral voltages sum magnitude with the “Gross Over Voltage Level,” “Lockout Level,” and “alarm Level” setpoint values, if enabled. If the compensated intermediate tap-point-to-neutral magnitude exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The control will lockout the bank if the “Gross Over Voltage Level” or the “Lockout Level” setpoint value is exceeded. Or issue an alarm if the “Alarm Level” setpoint value is exceeded.

**Ungrounded Wye Shunt Reactors**

The BankGuard PLUS Automatic Control Device provides protection of ungrounded, wye-connected shunt reactors, see Figure 5, either 3-phase reactors or 3-phase banks of single-phase reactors. The control device detects turn-to-turn faults in the windings of these shunt reactors, the most common mode of reactor failure. When a developing turn-to-turn fault occurs in any phase winding, the shunt reactor is protected from further damage by automatic switching provided by the control device. The control device locks out the entire shunt reactor when the neutral-to-ground voltage exceeds the calculated level. (See the Setup Instruction Sheet 1011-530 for more details.) In general, you should enable the unbalance compensation feature if the magnitude of the calculated error voltage caused by inherent reactor unbalance resulting from manufacturing-tolerance variations among the phase windings approaches 50% of the desired lockout-level setting.

For ungrounded, wye-connected shunt reactors, the control device uses an analog input and digital voltmeter to detect the reactor neutral-to-ground voltage, as monitored by an S&C 15-Volt-Ampere Potential Device. A digital filter attenuates harmonics and noise.

When the Unbalance Compensation feature is disabled, the magnitude of the real-time neutral-to-ground voltage is compared with the “Gross Over Voltage Level,” “Lockout Level”, and “Alarm Level” setpoint values, if enabled. Reactor-turn failures will cause the real-time neutral-to-ground voltage magnitude to change. If the real-time neutral-to-ground voltage magnitude exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The control will lock the reactor out if the “Gross Over Voltage Level” or the “Lockout Level” setpoint value is exceeded. The control will issue an alarm if the “Alarm Level” setpoint value is exceeded.

In addition to the neutral-to-ground potential device, one 30-Volt-Ampere S&C Potential Device is required to be installed on any one of the line phases to obtain a reference angle when the Unbalance Compensation feature is set to “Reactor” only. During the setup of the Unbalance Compensation feature, a neutral-to-ground voltage magnitude sample and a reference angle (Aref) sample are used to obtain and store an approximate magnitude correction value (see Signal Processing below for an explanation of
how the value is calculated). Setup of the Unbalance Compensation feature should be accomplished during a time when any voltage unbalances caused by the loads are minimal. During each control cycle, the stored, approximate magnitude correction value is subtracted from the real-time neutral-to-ground voltage magnitude to obtain a compensated neutral-to-ground voltage magnitude. Reactor-turn failures will cause the real-time neutral-to-ground voltage magnitude to change and, therefore, change the compensated neutral-to-ground voltage magnitude. The control compares the compensated neutral-to-ground voltage magnitude with the "Gross Over Voltage Level", "Lockout Level", and "Alarm Level" setpoint values, if enabled. If the compensated neutral-to-ground magnitude exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The control will lockout the bank if the "Gross Over Voltage Level" or the "Lockout Level" setpoint value is exceeded, or issue an alarm if the "Alarm Level" setpoint value is exceeded. The "Reactor Only" value is generally selected when the voltage variations between the line phases are expected to be negligible in comparison to the neutral-to-ground voltage changes resulting from the loss of reactor turns.

In addition to the neutral-to-ground potential device, three S&C 30-Volt-Ampere Potential Devices are required to be installed on each line phase when the "Unbalance Compensation" feature is set to "Reactor/Line". The control uses the three potential devices to obtain the sum of the line voltages magnitude and a reference angle. Since the sum is obtained from all the line voltages, compensation for fixed system imbalances is provided. During the setup of the unbalance compensation feature, a neutral-to-ground voltage magnitude sample, a sum of the line voltages sample and the reference angle are used to calculate and store a magnitude correction value (see Signal Processing below for an explanation of how the value is calculated. During each control cycle, the stored magnitude correction factor is subtracted from the real-time neutral-to-ground magnitude to obtain a compensated neutral to ground voltage magnitude. Reactor-turn failures will cause the real-time line-to-neutral voltage to change and therefore change the compensated neutral-to-ground voltage magnitude. The control compares the compensated neutral-to-ground voltage magnitude to the "Gross Over Voltage Level," "Lockout Level," and "Alarm Level" setpoint values, if enabled. If the compensated neutral-to-ground voltage magnitude exceeds a setpoint value continuously for a time greater than the applicable time delay setpoint value, the appropriate control action is taken. The control will lock out the bank if the "Gross Over Voltage Level" or the "Lockout Level" setpoint values are exceeded. The control will issue an alarm if the "Alarm Level" setpoint value is exceeded.
Signal Processing

The BankGuard PLUS hardware samples the sensor(s) analog output waveform and then converts the samples to digital values, see Figure 6. The control’s software processes the digital values using a Discrete Fourier Transform algorithm and compares the results to the applicable setpoint value. The comparisons are made at 200 millisecond intervals. Upon completion of the comparisons control action is then taken, if appropriate.

When an ungrounded wye capacitor bank installation has the Unbalance Compensation feature disabled, the Discrete Fourier Transform algorithm yields the magnitude of the neutral-to-ground voltage. This magnitude is then compared to the setpoint value(s) to determine if any control action is to be executed.

When an ungrounded wye capacitor bank has the Unbalance Compensation feature set to “Cap Only,” the Discrete Fourier Transform algorithm yields the magnitude of the neutral-to-ground voltage ($|V_{N-G}|$) and the value of the phase angle ($A_{ref}$) between the neutral-to-ground voltage and the reference line voltage. Using the Law of Cosines, an approximate correct magnitude is obtained utilizing the reference angle (See Figure 4-4). An approximate corrected magnitude is calculated and stored in the control’s
memory during the feature’s setup procedure. When the control is operating, the stored approximate corrected magnitude is subtracted from the real-time neutral-to-ground voltage magnitude during each 200 milliseconds to obtain a compensated neutral-to-ground voltage magnitude. The compensated neutral-to-ground voltage magnitude is then compared to the setpoint value(s). If the compensated neutral-to-ground voltage magnitude exceeds a setpoint value, then the appropriate control action will be taken.

![Law of Cosines](image)

**Figure 7. Approximate Corrected Magnitude**

For an ungrounded wye capacitor bank with the Unbalance Compensation feature set to “Cap/Line,” the Discrete Fourier Transform algorithm yields the magnitude of the neutral-to-ground voltage, the magnitude of the sum of the line voltages ($|V_{L-G\sum}|$) and a reference angle ($A_{ref}$). Since the sum is obtained from the three line voltages, compensation for fixed system voltage imbalances is provided in addition to capacitor unit manufacturing tolerance. Using the Law of Cosines, a corrected magnitude is obtained (See Figure 4-5). A corrected magnitude is calculated and stored in the control’s memory during the feature’s setup procedure. When the control is operating, the stored corrected magnitude is subtracted from the real-time neutral-to-ground voltage each 200 milliseconds to obtain a compensated neutral-to-ground voltage magnitude. The compensated neutral-to-ground voltage magnitude is then compared to the setpoint value(s). Capacitor unit failures will cause a change to the real-time neutral-to-ground voltage magnitude. Therefore, the compensated neutral-to-ground voltage will also change. If the compensated neutral-to-ground voltage magnitude exceeds a setpoint value, then the appropriate control action will be taken.

![Law of Cosines](image)

**Figure 8. Corrected Magnitude**

For a grounded wye capacitor bank installation with the Unbalance Compensation feature disabled, the Discrete Fourier Transform algorithm yields the magnitude of the sum of the tap-point-to-ground voltages (in percent). Capacitor unit failures will cause a change to the magnitude of the real-time sum of the tap-point-to-ground voltages. If the magnitude of the sum of the tap-point-to-ground voltages exceeds a setpoint value(s), then the appropriate control action will be taken.

For a grounded wye capacitor bank with the Unbalance Compensation feature set to “Enable”, the Discrete Fourier Transform algorithm yields the magnitude of the sum of the intermediate tap-point voltages ($|V_{tap\sum}|$) and the value of the phase angle ($A_{ref}$)
between the tap-point voltages sum and the reference line voltage. Using the Law of Cosines, an approximate corrected magnitude is obtained utilizing the reference angle (See Figure 4-6). An approximate corrected magnitude is calculated and stored in the control's memory during the feature’s setup procedure. When the control is operating, the stored, approximate corrected magnitude is subtracted from the real-time tap-point-to-ground voltages magnitude (in percent) during each 200 milliseconds to obtain a compensated neutral-to-ground voltage magnitude. The compensated neutral-to-ground voltage magnitude is then compared to the setpoint value(s). The calculation on the compensated neutral-to-ground voltage value is the same as for an ungrounded, wye-connected shunt capacitor bank. Capacitor unit failures will cause a change to the magnitude of the real-time tap-point-to-ground voltages sum and the reference angle. Therefore, the magnitude of the compensated neutral-to-ground voltages sum magnitude will also change. If the magnitude of the compensated neutral-to-ground voltages sum magnitude exceeds a setpoint value, the appropriate control action will then be taken.

\[ b = \left| V_{\text{Tap sum}} \right| \]

\[ a = \sqrt{b^2 + c^2 - 2bc \cos A_{\text{ref}}} \]

\[ c = \left| V_{\text{Tap sum}} \right| \]

Figure 9. Approximate Corrected Magnitude
You can use the Report feature to save the Control Device software settings and stored data to your computer as a CSV (comma-separated value) file. You can keep the report as a permanent record and use the report data in spreadsheets or other types of programs.

1. **Connect your portable computer to the control device and start the IntelliLINK software.**

   For details, see *To Start the IntelliLINK Software* in the Setup Instruction Sheet 1011-530. If your computer is already connected to the control device, you can skip this step.

2. **From the Data menu, choose Reports.**

3. **In the dialog box, select the type of report you want to generate, then click OK.**

   There are four kinds of reports:
   - Full – Includes all the information contained in the control device.
   - System Setup and Operation – Contains the configuration data for the control device.
   - Troubleshooting Information – Contains the information recorded in the troubleshooting logs.
   - Historical Data – Contains the daily statistics, the potential device profiles, the switching data, and the log of power outages.

4. **In the Save Report dialog box, specify a name and location for this report, then click OK.**

   If you do not specify a location, the file is saved to the same directory as the program files for this for this type of control device. The extension “.CSV” is added automatically.

   When the report is complete, the message “Task completed” appears on the status line of the Writing Report dialog box.
Saving and Loading Setup Configurations

If several control devices use a similar setup configuration and the same software version, you can save the configuration from one control device and load it into the others. Then you only need to manually adjust the setpoints that are different for each control device.

**Saving a Setup Configuration**

1. **Determine which control device contains the configuration you want to save.**

2. **Connect your computer to the selected control device and start the IntelliLINK software.**

   For details, see To Start the IntelliLINK Software in the Setup Instruction Sheet 1011-530. If your computer is already connected to the control device, you can skip this step.

3. **From the File menu, choose Save Setpoints.**

4. **In the Save Setpoints dialog box, specify a name and location for this configuration file, then click Save.**

   If you do not specify a location, the file is saved to the same directory as the program files for this for this type of control device. The extension “.CFG” is added automatically.

   ◆ **NOTE:** This process does not save the “Location” (on the SETUP screen) or the “Communications RTU Address” (on Page 1 of the Communications Setup screen).

**Loading a Saved Configuration**

1. **If necessary, connect your computer to the control device where you want to load the configuration, then start the IntelliLINK software.**

   For details, see To Start the IntelliLINK Software in the Setup Instruction Sheet 1011-530. If your computer is already connected to the control device, you can skip this step.

2. **From the File menu, choose Open Setpoints.**

3. **In the dialog box, select the CFG file for the configuration you want to load, then click Open.**

4. **Make any setpoint changes that are required for this control device.**

   For details, see the Setup Instruction Sheet 1011-530.

---

**NOTICE**

Be sure to enter the correct values for “Location” (on the SETUP screen) and, if necessary, the “Communications RTU Address” (on Page 1 of the Communications Setup screen).
To view the IntelliLINK screens and Help file without connecting to a control device or a snapshot:

1. **Start the IntelliLINK software on your computer.**

2. **During startup, click Cancel to close the Connect dialog box.**
   
   If the IntelliLINK software is already running, choose Disconnect from the Connection menu, then choose Close Screenset from the File menu, to clear the present screenset from memory.

3. **From the File menu, choose Open Screenset.**

4. **In the Open Screenset dialog box, find and select the WMN file whose name matches the version name on the Setup software disk for this control device.**
You can save operational and data logging information in “snapshots” (VM, virtual memory files). These snapshots let you view data, generate a report, and save or change setpoint configurations even when you are not connected to a control device. To access the stored information, you “connect” to the snapshot instead of the physical control device. Each control device Setup disk includes a sample snapshot.

**Save Control Settings and Data to a Snapshot**

1. **Connect your computer to the control device from which you want save information**, then start the IntelliLINK software.
   
   For details, see To Start the IntelliLINK Software in the Setup Instruction Sheet 1011-530. If your computer is already connected to the control device, you can skip this step.

2. **From the File menu, choose Save Snapshot.**

3. **In the dialog box, specify a file name and location for this snapshot, then click Save.**
   
   If you do not specify a location, the file is saved to the same directory as the program files for this for this type of control device. The extension “.VM” is added automatically.

**View (Connect To) a Snapshot**

1. **Start the IntelliLINK software on your computer. During startup, click Cancel to close the Connect dialog box.**
   
   If the IntelliLINK software is already running, choose Disconnect from the Connection menu, then choose Close Screenset from the File menu, to clear the present screenset from memory.

2. **From the File menu, choose Open Snapshot.**
   
   The Open Controller Data File dialog box opens.

3. **Select the snapshot that you want to use, then click Open.**

4. **If you plan to change the configuration settings in the snapshot, click Yes at the Connect to File dialog box. If you want to avoid accidentally changing a setting, click No.**
   
   The IntelliLINK software opens and displays the contents of the selected snapshot.

**Save Changes You Make to the Snapshot**

All changes you make to configuration settings in the snapshot are automatically saved to disk immediately. You do not need to "save" the changes in a separate operation.

**Generate a Report From a Snapshot**

Follow the same procedure as when you are connected to a control device. For details, see “Generating Reports” on page 23.

**Create a CFG File From a Snapshot**

This procedure allows you to prepare a setpoint configuration for a control device which is in the field while you do not have access to a comparable device.

1. **Connect to the snapshot.**
   
   For details, see “View (Connect To) a Snapshot” on page 20.
2. **Change the configuration settings in the snapshot as needed.**
   For details, see the *Setup* Instruction Sheet 1011-530.

3. **From the File menu, choose Save Setpoints.**

4. **In the Save Setpoints dialog box, specify a name and location for this configuration file, then click Save.**
   If you do not specify a location, the file is saved to the same directory as the program files for this type of control device. The extension ".CFG" is added automatically.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>This process does not save the “Location” (on the SETUP screen) or the “Communications RTU Address” (on Page 1 of the <em>Communications Setup</em> screen).</td>
</tr>
</tbody>
</table>
Occasionally, you may need to update the software that is stored in the control device (the Control Device software). The Update program, installed with the IntelliLINK software, lets you easily replace the old Control Device software with the newer version.

**NOTICE**
The setpoint values and historical data stored in the control device may be lost during the update process. Generate all required reports using the original IntelliLINK and Control Device software, before you update the Control Device software.

1. **Install the contents of the new Setup disk on your computer.**
   For details, see *To Start the IntelliLINK Software* in the *Setup* Instruction Sheet 1011-530.

2. **Connect your computer to the LOCAL COMM PORT or optical port on the control device.**

3. **Start the Update program.**
   
   A. In Windows, choose Start menu > Programs > EnergyLine > Update. The Update window appears (Figure 10).

   ![Figure 10. Control Device Software Update Window](image)

   B. Select the desired options, then click Start Update.

   ◆ **NOTE:** If your control device is not connected to COM1 on your computer, click on the Communication Setup tab, select the correct comm port, click Connect, and then return to the Update Control Device Software tab and click Start Update.

   The update process takes 5 to 10 minutes. You can follow the progress in the lower right corner of the window. Once the update is complete, the window automatically closes.
NOTE: If the software on the disk is not the same type as the software in the control device, an error message appears. Note which software version is in the control device, then press <Enter> to abort the update process. When you have the correct new software version, repeat the steps above.

⚠️ CAUTION

If you cancel the update process once it has started, you deactivate the software in the control device. If you must cancel the process, start the update process again.